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Abstract 
A recent project determining the hydraulically suitable habitat available for the Rio Grande 

Silvery Minnow (RGSM) has indicated that perched channels require special modeling 

techniques. One-dimensional (1-D) modeling cannot account for changes in the lateral flow 

component when distributing water throughout a cross section. A single water surface elevation 

line will be used to portray the flow in a cross section. In a perched channel, the floodplain will 

have a lower ground elevation than the bed of the main channel, so water will be distributed into 

the floodplains any time water is in the main channel, when in reality, water will fill the main 

channel first. Once bankfull conditions have been reached, the water will spill over the top of 

bank points and collect at the lowest elevation, meaning there will be at least two water surface 

elevations - one in the main channel and one in each floodplain- for many of the discharges 

being modeled.  

Several techniques are described in this paper on how to better handle the flow distribution in a 

perched channel using a 1-D model. First, the effects of varying the number of flow distribution 

slices between the floodplains and the main channel were observed. Looking more specifically at 

perched rivers, analyses of floodplain hydraulic conditions can be performed by manually 

controlling the amount of water inundating the floodplains through the use of a blocked 

obstruction in the channel (for flows greater than bankfull discharge). To examine conditions 

within the channel at lower flows, computational levees may be placed at the top of bank points. 

If the analysis requires running flows greater than the bankfull discharge, which can be estimated 

using HEC-RAS’s levee freeboard feature, then the computational levees should be removed to 

allow water to inundate the floodplains. 

The Escondida reach, a reach of the middle Rio Grande that contains perched cross sections, was 

used to test these various techniques to determine the effects on predicted RGSM habitat. 

Varying the number of flow distribution slices in the main channel and floodplains leads to 

larger discrepancies in predicted habitat at higher discharges. Computational levees were set 

throughout the Escondida reach. The amount of water being misplaced into the floodplains was 

determined. Out of a total of 163 cross sections, 128 cross sections had varying amounts of water 

(between 10 and 70 percent) placed in the floodplains before bankfull was reached. The cross 

sections that had higher percentages of misplaced water corresponded to the two subreaches that 

have a greater amount of perching. Based on one perched subreach in the Escondida reach, the 

blocked obstruction method predicted slightly higher hydraulically suitable habitat areas than 

without using the blocked obstruction method. The computational levees should be removed, and 

the blocked obstruction will only be placed in the channel, at flows greater than bankfull 

discharge. 
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Background 
Anthropogenic changes have significantly impacted the geomorphology of the Middle Rio 

Grande (MRG), which is a portion of the Rio Grande beginning at the Cochiti Dam and 

continuing to Elephant Butte Reservoir. In the past, floods helped maintain aquatic ecosystems 

by enabling connection of water between the main channel and the floodplains (Scurlock, 1998), 

but consequently threatened human establishments that were built near the Rio Grande. 

Beginning in the 1930s, levees were installed to prevent flooding, while dams were used to store 

and regulate flow in the river. In the 1950s, the USBR commenced a channelization effort, which 

involved straightening the channel and the addition of levees. While these efforts enabled 

agriculture and large-scale human developments to thrive along the MRG, they also 

fundamentally changed the river, which led to reduced peak flows and sediment supply while 

altering the channel geometry and vegetation (Makar, 2006).   

The Rio Grande Silvery Minnow (RGSM or silvery minnow) is one species of fish that has had 

its habitat significantly reduced over time. One of the most important aspects of silvery minnow 

habitat is the connection of the main channel to the floodplain. Spawning is stimulated by peak 

flows in late April to early June. These flows should create shallow water conditions on the 

floodplains, which is ideal nursery habitat for the silvery minnow (Mortensen et al., 2019). As 

the amount of river that was hydraulically suitable for the RGSM has become more limited, the 

fish population has declined leading to a listing on the Endangered Species List in 1994. 

Modeling of the river has become important in analyzing the changes of the MRG to provide 

information that could be useful in future efforts to save the RGSM.  
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Introduction 
HEC-RAS one-dimensional modeling was the primary tool used to analyze the depth and 

velocity criteria throughout the MRG. The upper reaches of the MRG could be modeled 

reasonably well using a one-dimensional (1-D) model. Closer to Elephant Butte Reservoir, long 

term aggradation has raised the top of bank points and main channel elevation to an elevation 

that is higher than the surrounding floodplains. This has led to difficulties with 1-D modeling and 

the need for new techniques. 

A river is considered perched “when the main channel elevation is above the adjacent 

floodplain” (Baird and Holste, 2020). This can occur from flooding or periods of higher 

discharges, when greater amounts of sediment are deposited along the banks forming natural 

levees. Over time the channel bed is elevated and may eventually be considerably higher than the 

ground elevation of the adjacent floodplains. Figure 1 provides an example of a perched cross 

section in the Middle Rio Grande. Perched channels can result in a higher flooding potential to 

the floodplains, which can have both positive and negative impacts on those areas. The floods 

may be detrimental to infrastructure or crops, leading to costly repairs or replacements. Water 

inundation of the floodplains may provide temporary habitat for aquatic species, birds or animals 

that rely on slower moving water. However, the fact that these sudden expansions of habitat is 

only temporary is important to note. The purpose of the analysis can help determine which type 

of modeling should be used. 

 
Figure 1 Example of a cross section of a perched channel in the Middle Rio Grande 
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One-dimensional modeling calculates the discharge and velocity along a vector in one direction 

only: perpendicular to the cross section. There can only be one calculated water surface elevation 

(WSE) for each cross section and lateral flow cannot be considered. The conservation of mass 

and energy is applied using a standard step method to calculate the WSE at all cross sections in 

the analyzed reach. Head losses are considered, such as friction losses based on the Manning’s n 

values that are provided by the user. The benefits of 1-D modeling are that it is one of the most 

basic approaches to modeling a river reach and it requires less data. In addition, a model can be 

created and run fairly quickly. Conversely, there are also a few aspects of 1-D modeling that will 

not work in all applications. For instance, HEC-RAS will assign water beginning from the lowest 

elevation in the cross section and move upwards. If the cross section contains any locations 

where the ground location in a floodplain is lower than that of the main channel, water will be 

inaccurately placed in the lower elevations. In that case, the single WSE line will be 

overestimating water in the floodplains and underestimating water in the channel. Depending on 

the purpose of the analysis, this may be acceptable. For example, if an area is being analyzed for 

a flood hazard risk, a small overestimation of water in the floodplains might be tolerable. In the 

case of measuring hydraulically suitable habitat based on flow depth and velocity criteria, a more 

precise WSE is essential in an accurate estimate of habitat. For this reason, 1-D modeling is 

generally not recommended for perched channels. However, for cases such as the RGSM habitat 

project, data limitations may necessitate the use of 1-D modeling.  

Two-dimensional (2-D) modeling can predict the depth-averaged velocity and water surface 

elevation in two dimensions, so it can handle changes in lateral flow. This is important for rivers 

with wide width to length ratios or any time lateral flow is expected. Therefore, a 2-D model is 

recommended for perched channels whenever possible to provide a more accurate distribution of 

water throughout each cross section. 2-D modeling requires a greater amount of topographical 

data and larger spatial scales. In addition, 2-D models may have a longer run time. However, as 

technology continues to improve this may become less and less of an issue. 

The purpose of this report is to describe several techniques that can be used when modeling a 

perched channel with a 1-D model. The first technique involves the use of computational levees. 

For any analyses involving a discharge less than bankfull conditions, the computational levees 

should be used to contain the placement of water to the main channel only. To estimate the 

bankfull conditions, or to determine the discharge at which the computational levees should be 

removed, a “levee freeboard” feature in HEC-RAS can be used to determine when the levees are 

being overtopped. Another technique for perched channels if the analysis will be continuing 

beyond bankfull conditions is the use of a blocked obstruction in the main channel. Depending 

on the percentage of flow being diverted away from the main channel into the floodplains, a 

blocked obstruction can be placed within the main channel for flows greater than the bankfull 

discharge. After bankfull, the conditions in the main channel should not change, so the focus 

would be directed to the floodplains. Finally, after the computational levees have been placed 

and it has been determined whether or not to use a blocked obstruction, the velocity and depth 

throughout a cross section can be evaluated using the flow distribution feature in HEC-RAS. A 

final analysis was completed in this report to determine how many vertical flow distribution 

slices should be assigned to the main channel and how many should be assigned to the 
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floodplains.  This is somewhat dependent on the resolution of the cross-section geometry. If the 

number of flow distribution slices exceeds the resolution of the ground surface points, adding 

additional slices will not be necessary. In previous reports, 20 flow distribution slices were 

assigned to each channel while 5 flow distribution slices were assigned to the main channel. 

Hydraulically suitable habitat based on variations of the flow distributions indicated that there 

was not a significant difference when it comes to the velocities and depths of the RGSM.
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Depth and Velocity Measurements 
The project in the MRG involves calculating depth and velocity throughout each cross section. 

The Rio Grande Silvery Minnow (RGSM or silvery minnow) is an endangered fish species that 

is native to the Middle Rio Grande. The RGSM require specific velocity and depth ranges 

depending on the life stage that the fish is in. Table 1 outlines these velocity and depth 

guidelines. 

Table 1 Rio Grande Silvery Minnow habitat velocity and depth range requirements (from Mortensen et al., 2019) 

 Velocity (cm/s) Depth (cm) 

Adult Habitat <40 >5 and <60 

Juvenile Habitat <30 >1 and <50 

Larvae Habitat <5 <15 

 

HEC-RAS has the capability to perform a flow distribution analysis to calculate the laterally 

varying velocities, discharges, and depths throughout a cross section as described in chapter 4 of 

the HEC-RAS Hydraulic Reference Manual (US Army Corps of Engineers, 2016). Each cross 

section can be divided into a set number of slices up to 45, where the 45 slices can be divided up 

among the main channel and the right and left floodplains. Because the RGSM relies heavily on 

floodplains for habitat (due to higher velocities and depths in the main channel) and the 

floodplains contain more variability than the main channel, 20 width slices were assigned in each 

floodplain and 5 width slices in the channel. However, based off of the method to use 

computational levees to contain the flow within the main channel, there would not be water in 

the floodplains until after bankfull discharge is reached. In that case, it may be beneficial to 

assign more or all of the slices to the main channel at any discharges less than bankfull 

discharge.  

A sensitivity analysis was completed to determine at what point the resolution in the channel has 

less of an impact. The sensitivity analysis compares five trials. A HEC-RAS model was run for 

each trial. Trial one was the original model used for the RGSM habitat analysis in the MRG. 

There were five flow distribution slices assigned to the channel and 20 flow distribution slices 

assigned to the floodplains. The RGSM depends highly on the floodplains for their habitat, so it 

was important to have high resolution on the floodplains. Using the 1-D modeling techniques 

with the computational levees, flow is being constrained in the main channel up until bankfull. 

Therefore, it is assumed that water is not getting out onto the floodplains, so it is possible more 

resolution should be focused in the main channel at discharges less than bankfull. Trials 2 

through 5 test an increasing number of flow distribution slices in the main channel and fewer 

flow distribution slices in each floodplain. Table 2 displays the corresponding number of flow 

distribution slices in the channel and floodplain for each trial. 

 
  



6 
 

Table 2 Breakdown of flow distribution slices for flows less than bankfull discharge. 

 Channel Each Floodplain 

Original 5 20 

Trial 2 15 15 

Trial 3 25 10 

Trial 4 35 5 

Trial 5 43 1 

 

The analysis was completed for discharges up to bankfull discharge because after bankfull has 

been reached, conditions in the main channel will not change, and the higher resolution on the 

floodplains is desired. One example cross section was selected to display three of the trials flow 

distribution outputs in Figure 2. For this example, there was a discharge of 3000 cfs. When only 

5 flow distribution slices are assigned to the main channel, it appears that there is a greater area 

of water with lower velocities, due to the averaging between areas of slow velocity and the faster 

moving water at the center of the main channel. Trials 3, 4, and 5 all looked very similar in terms 

of the velocity distribution indicating that, for these geometry files, there is no significant benefit 

in channel resolution by assigning more than 25 flow distribution slices. The cross sections with 

the flow distribution slices at 3,000 cfs for all trials are provided in Appendix B.  

The larval, juvenile, and adult habitat were calculated for each of the five variations of flow 

distribution slices and are displayed in Figure 3. Above 1,500 cfs, there is an increase in 

calculated habitat with more resolution in the main channel up until Trial 5 (43 slices in the main 

channel and 1 slice in each floodplain) likely because the resolution in the floodplains is so low. 

Although this was before bankfull, some cross sections experience overtopping of the 

computational levees, so habitat in the floodplains was playing some roll in total habitat 

available. The hydraulically suitable habitat predictions broken up by subreach are provided in 

Appendix C. 
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Figure 2 Trial 1 (Top), Trial 2 (Middle), Trial 5 (Bottom) with 5, 15, and 43 flow 
distribution slices assigned to the main channel, respectively. 
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Figure 3  Larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of flow distribution 

slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in the left and 
right floodplains and 5 slices in the main channel.
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Perched Channels 
A perched channel is defined as a main channel that has an elevation that is higher than the 

surrounding floodplains. This can occur from long term aggradation raising the elevation of the 

banks of the river and the channel elevation. The low-lying floodplains of perched channels can 

experience flooding problems. These areas may also provide areas of habitat for aquatic species. 

However, as the discharge of the river decreases, they may become disconnected from the 

channel. This can be problematic if fish become stranded in the disconnected areas or the fish 

may not be able to travel to those areas. Perched channels can lead to difficulty in 1-D modeling 

due to the fact that 1-D modeling will only use one water surface elevation through a cross 

section. So, if there are any locations with a cross section that have an elevation lower than that 

of the main channel, techniques need to be used to contain the water in the correct locations. In a 

realistic system, the water surface elevation would rise within the channel with an increasing 

discharge. Once bankfull has been reached, the water will spill out of the channel and begin 

filling the floodplains from the ground elevation up. However, the 1-D model only allows for 

one WSE line as shown in Figure 4.  

 
Figure 4 Example of 1-D water placement using one water surface elevation 
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As seen in Figure 4, the main channel is not close to bankfull discharge, yet there is already 

water inundation of the floodplains. This is due to the inability of 1-D models to handle lateral 

flow. HEC-RAS will place water beginning from the lowest elevation first, so any areas that 

have a ground elevation lower than that water surface elevation, such as in perched channels, 

will be inundated unless manual constraints are placed. If several cross sections experience 

perching, this may not lead to significant problems in the results. However, if a large proportion 

of a reach is perched, the results may be inaccurate. 
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Focusing on the Floodplain 
A blocked obstruction is a tool available in HEC-RAS that may be useful when modeling 

perched channels. This feature can be placed in a specified location of the cross-section to 

prevent inundation of that area. One technique to use when analyzing the floodplains of perched 

channels (which would occur at flows higher than the bankfull discharge) is to place a blocked 

obstruction in the main channel as seen in Figure 5. Note that, in this case, there is a second 

blocked obstruction placed in a low flow channel on the far right. 

 
Figure 5 Example of a cross section with a blocked obstruction placed in the main channel 

As discharge increases, the main channel fills until bankfull conditions. After this, the main 

channel cannot contain a greater discharge, so the depth and velocity within the channel would 

remain the same. However, as discharge continues to increase, the depth throughout the 

floodplains will also increase. This process can be simulated by running two models: discharges 

up to bankfull without a blocked obstruction and discharges greater than bankfull discharge with 

a blocked obstruction in the main channel. 

First, computational levees would be assigned at the top of bank points. The model would be run 

up to bankfull conditions. If discharges greater than bankfull are required, a second model would 
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be run. In this model, the levees would be removed, but a blocked obstruction would be placed 

throughout the main channel. For all flows greater than bankfull discharge, the conditions within 

the main channel would not change, therefore those results would remain the same and the focus 

moves to the floodplains. With the blocked obstruction in the main channel, all flow that is input 

is assigned to the floodplains. Because of this, the desired flows that are input in HEC-RAS 

should be reduced by the bankfull discharge amount. Table 3 illustrates the model set up with the 

use of a blocked obstruction in the main channel. 

Table 3 Input discharge and division of flow between the main channel and floodplains 

Total 

Discharge 

(cfs) 

Bankfull 

Discharge 

(cfs) 

Blocked 

Obstruction 

Input 

Discharge 

(cfs) 

Discharge in 

Channel 

 (cfs) 

Discharge in 

Floodplains 

(cfs) 

1000 3000 No 1000 1000 0 

2000 3000 No 2000 2000 0 

3000 3000 No 3000 3000 0 

4000 3000 Yes 1000 0 1000 

5000 3000 Yes 2000 0 2000 

6000 3000 Yes 3000 0 3000 

7000 3000 Yes 4000 0 4000 

 

Prior to setting up the second model with the blocked obstruction, a test can be performed to 

determine the percentage of flow that is being contained within the main channel. To determine 

the percent of flow being diverted into the floodplains, the following steps can be taken. 

View > Profile Summary Table > Options > 

 Define Table > Filter > Type in “Q Perc” 

The percentage of discharge in the main channel and the percentage of discharge in each 

floodplain (shown in Figure 6) should be exported to excel or another desired program for 

further analysis.  

 
Figure 6 Three variables from HEC-RAS used determine the percentage of water being placed in the floodplains throughout a 

reach. 

These statistics were obtained for a reach in the Middle Rio Grande that has perching in the 

downstream half of the reach. A model of 3,500 cfs was run through the Escondida reach. A 

value of 3,500 cfs was determined as the average bankfull throughout the reach. A plot (Figure 

7) was developed with the agg/deg lines on the x-axis and the discharge that was placed in the 

channel on the y-axis. Between agg/deg lines 1400 and 1420, there is a decrease in the amount of 
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water placed in the main channel. Another decrease occurred between agg/deg lines 1450 and 

1475. Perching was more prominent in agg/deg lines greater than 1397. The dip in the amount of 

water in the main channel could either indicate that a greater percentage of the flow was being 

inaccurately distributed to the floodplains or it is possible that the area of the main channel was 

smaller in these sections of the reach. 

 

 
Figure 7 Flow placed in the main channel at agg/deg lines 1313 to 1475 when an input of 3,500 cfs is run through the reach. A 

discharge of 3,500 cfs is the average bankfull discharge throughout the Escondida reach in the Middle Rio Grande. 

 

To further investigate the reasoning behind these dips in discharge, the bankfull discharge was 

estimated at each cross section using the overtopping feature in HEC-RAS. Then, the reach’s 

average bankfull discharge (3,500 cfs) was applied through the reach. If the bankfull discharge at 

a given cross section was greater than 3,500 cfs, then all of the flow should be in the main 

channel.  

Figure 8 shows a plot of the main channel’s discharge minus the cross section’s bankfull 

discharge for the Escondida reach. The discharge in the main channel (at a flow of 3,500 cfs) 

was subtracted from the bankfull discharge at each cross section. If this subtraction results in a 

negative number, then the cross section’s bankfull discharge is smaller than the reach’s average 

bankfull discharge. A positive number means that the reach’s average bankfull discharge is 

smaller than that cross section’s bankfull discharge estimate. There were 15 cross sections with a 



14 
 

bankfull discharge smaller than 3,500 cfs which accounts for the decrease in discharge in the 

main channel in those cross sections. 

 
Figure 8 The difference between the discharge in the main channel and the bankfull discharge at each cross section. A positive 

number indicates that the bankfull discharge of the channel is larger than the average bankfull discharge and there is still more 
room in the main channel at a flow of 3,500 cfs. A negative number indicates that the cross section’s bankfull discharge estimate 

is smaller than the reach’s average bankfull estimate.  

However, 128 cross sections had some discharge placed into the floodplain before bankfull 

discharge was reached. In most cases, the amount was small (<10%). However, there were quite 

a few cross sections where the percent misplaced in the floodplain was greater, as shown in 

Table 4. The plot of the percentage of flow misplaced to the floodplain is shown in Figure 9. For 

this analysis, the cross sections with smaller estimated bankfull discharges were removed to 

show only the cross sections that are misplacing flow in the floodplain. 

Table 4 Number of cross sections that have an incorrect distribution of water between the floodplain and channel 

Percent 
Misplaced (%) 

Number of 
XS 

>10 35 

>20 31 

>30 24 

>40 20 

>50 15 

>60 9 

>70 0 

-4000

-2000

0

2000

4000

6000

8000

10000

1300 1320 1340 1360 1380 1400 1420 1440 1460 1480 1500

B
an

kf
u

ll-
Fl

o
w

 in
 C

h
an

n
el

 (
cf

s)

Agg/Deg Line

Excess Room in Channel 



15 
 

 

  
Figure 9 Percentage of flow that should be in the channel yet is placed in the floodplain due to perching of the channel. 

 

Subreach E3, a subreach characteristic of perching, was used to compare the effects on the 

habitat predictions with and without the use of a blocked obstruction in the main channel. Figure 

10 shows the habitat curves generated using the blocked obstruction method versus the original 

method in which the channel was left open, and water was misplaced in the floodplain. In this 

case, the blocked obstruction method only changes the habitat results above bankfull discharge. 

In this subreach, the method selected has the greatest affects on the larval and juvenile habitat 

predictions between 4,000 and 6,000 cfs. Figure 11 compares the amount of habitat predicted 

and suggests that the blocked obstruction method will typically predict a greater amount of 

hydraulically suitable habitat than the method without the use of blocked obstruction. 
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Figure 10 Habitat with and without a blocked obstruction in the main channel 
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Figure 11 Comparison of RGSM hydraulically suitable habitat estimates with and without the placement of a blocked obstruction 

in the main channel. 
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Use of Computational Levees to analyze Channel Conditions 
Computational levees are used to contain flow within specified areas of a cross section. A 

technique that may be used to model a perched channel with a 1-D modeling program is to use 

computational levees to manually contain the flow within the main channel. In reality, as 

discharge increases, the main channel will fill. Once the top of bank points are reached, the water 

will spill out of the channel and inundate the floodplains. In the case of a perched channel, the 

water will run down the banks and collect at the lowest elevation. Running a model above 

bankfull discharge requires another step. Overtopping of the levees can also lead to 

overestimation of water in the floodplains. Figure 12 shows the RAS-mapper results of an 

overhead view that has a model with computational levees being overtopped on the left, which 

results in an exaggerated depth (shown by the darker blue) compared to the model run without 

computational levees. 

 

Figure 12 Comparison between a model run with computational levees with overtopping (left) and no 
computational levees (right) 
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One downside to this technique is that the computational levees have to be manually set. If only 

cross section data are available, it can be difficult to find the exact location of top of bank point. 

There are often spikes in the ground surface data, so it can be hard to know which points may be 

incorrect measurements. Another problem with this technique is that all of the flow will be 

contained within the main channel unless overtopping occurs. It is possible that several low-lying 

areas in between cross sections may actually contain water. This may not be significant in all 

circumstances, but this needs to be considered depending on the use of analysis results. 

Figure 13 compares a cross section with and without the use of computational levees. The upper 

picture shows a cross section that needs to use computational levees to contain the flow within 

the main channel. The figure shows that the channel is perched and that much of the flow being 

distributed throughout the cross section is being assigned to the floodplain. Next, the lower 

picture shows that same cross section with the computational levees set at the original top of 

bank points. Water no longer inundates the floodplains at a discharge of 500 cfs in this cross 

section. 
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Figure 13 Comparison of cross section (agg/deg 1456) with a flow of 500 cfs without computational levees (top) and with 

computational levees (bottom) 
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Placement of Computational Levees 

Levees should be placed near the top of bank points. This would occur at the highest elevated 

ground containing the main channel. It is best to imagine water filling the main channel. At the 

point where water will spill over into the floodplains, the computational levee should be placed. 

It is useful to have aerial imagery of the river available to help identify islands that may look like 

a top of bank point on the cross-section profile. The computational levees should be set cross 

section by cross section throughout the entire reach. Figure 14 shows an example of a cross 

section with the original top of bank points in red and the computational levees as the pink 

squares. In some cases, the original top of bank points may be where the computational levee is 

assigned (like the left point in Figure 14). However, it is important to note that this is not always 

the case and should be confirmed by checking all of the cross sections. 

 
Figure 14 Correct placement of computational levees. The pink squares are the computational levees. Note there is a blocked 

obstruction in the channel on the right. 

Depending on the quality of cross section geometry, data collection points may include in spikes 

in elevation from inaccurate LiDAR measurements. The computational levees should be placed 

at locations at the top of bank with several similar points in elevation, rather than on the top of 

single point, which could be overestimating the ground elevation, and therefore bankfull 

discharge. Figure 15 shows an example of a LiDAR point that may have captured the elevation 
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of a tree or another tall object. In this example, that high point should not be assumed to be the 

top of bank point, and therefore a computational levee should not be assigned there. 

 
Figure 15 Possible inaccurate ground surface elevation measurement. Avoid placement of computational levee at this point. 

 

Notice there is only 

1 point indicating 

this large increase in 

ground elevation. 
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Freeboard Discharge 
If an analysis involves flows greater than the bankfull discharge, the computational levees need 

to be removed because at that point water is inundating the floodplains. If bankfull discharge is 

unknown, it is possible to estimate the bankfull discharge using another HEC-RAS feature: the 

left and right levee freeboard (shown in Figure 16).  

 
Figure 16 Left and right levee freeboard button in HEC-RAS 

To get to the left and right levee freeboard feature, the following steps can be followed:  

View > Profile Summary Table > Options > 

 Define Table > Filter > Type in “levee freeboard” 

This feature will determine whether or not a computational levee on the left or right of the 

channel has been overtopped (which is indicated by a negative freeboard value). For the report 

on the Middle Rio Grande, the computational levees are removed throughout the reach when 

25% of the cross sections are experiencing overtopping. Figure 17 shows an example plot of the 

freeboard discharge from the Escondida reach in the MRG. 

 
Figure 17 Bankfull discharge for five different sample years from Escondida Reach Report (Beckwith and Julien, 2020). 
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Conclusions 
When modeling perched channels or rivers experiencing lateral flow, two-dimensional modeling 

should be used if feasible in order to more efficiently and accurately capture the distribution of 

flow throughout a reach. However, data limitations may prevent the use of a two-dimensional 

modeling program. Computational levees, set at the upper most point along the banks of the 

main channel, should be used when working with perched channels to contain the flow within 

the main channel up until the bankfull discharge. At the bankfull discharge, computational levees 

should be removed to avoid overpredicting the depth of the water in the floodplain that comes 

from one-dimensional modeling’s requirement of a single water surface elevation line. The levee 

freeboard feature can be used to estimate the average bankfull discharge of the reach. Using the 

Escondida reach to perform sensitivity analyses on these tests, the following conclusions were 

made: 

▪ Varying the number of flow distribution slices in the main channel and floodplains leads 

to larger discrepancies in habitat at higher discharges. The predicted habitat throughout 

the Escondida reach varies up to 30-40% at flows less than bankfull discharge.  

▪ About 78.5% of cross sections in the Escondida reach experienced some amount of water 

being misplaced into the floodplains. While much of these were minor amounts, HEC-

RAS misplaced at least 50% of the flow in about 15% of the total cross sections 

throughout the reach. The greater amount of flow misplaced corresponded to the sections 

of the reach that had greater perching. 

▪ Applying the blocked obstruction method to a perched subreach of the Escondida reach 

resulted in hydraulically suitable habitat predictions that are approximately 5 to 15 % 

greater than the original method without the placement of the blocked obstruction in the 

main channel. 

▪ The computational levees should be removed when running analyses at discharges 

greater than bankfull (3,500 cfs for the Escondida reach in the year 2012). 
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Appendix A 
1-D vs 2-D Comparison 

In the technical report “One-Dimensional Numerical Modeling of Perched Channels", a cross 

section was used to compare the use of a 1-D and 2-D model (Baird and Holste, 2019). Figure A-

1 shows the 2-D model interpretation where water spills of the top of bank points and flows 

down to a lower water surface elevation. Figure A-2 shows the 1-D model interpretation where 

lateral flow cannot be considered and there is only one water surface elevation throughout the 

main channel and floodplains. 
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Appendix B 
Flow Distribution Slices Sensitivity Analysis 
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Appendix C 
Flow Distribution Slices in the Main Channel 

This appendix includes the habitat plots for each subreach that vary based on the number of flow 

distribution slices in the channel. By analyzing the changes on a subreach scale, it may be 

possible to identify when more flow distribution slices would be necessary in the main channel. 

Subreaches E3 and E5 have more perched cross sections. 
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Figure C- 1 Subreach E1 larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of 

flow distribution slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in 
the left and right floodplains and 5 slices in the main channel. 
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Figure C- 2 Subreach E2 larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of 

flow distribution slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in 
the left and right floodplains and 5 slices in the main channel. 
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Figure C- 3 Subreach E3 larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of 

flow distribution slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in 
the left and right floodplains and 5 slices in the main channel. 
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Figure C- 4 Subreach E4 larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of 

flow distribution slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in 
the left and right floodplains and 5 slices in the main channel. 
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Figure C- 5 Subreach E5 larval, juvenile, and adult RGSM habitat at discharges up to 3,000 cfs with variations in the number of 

flow distribution slices in the main channel and each flood plain. For example, in the legend, 20-5-20 means there are 20 slices in 
the left and right floodplains and 5 slices in the main channel. 
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